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Topic 1: Spreadsheets 

Definition  
Spreadsheet: application package designed to store, organize and manipulate numerical data and charts. 

 Also called electronic ledger. 

 Examples : MS Excel, Lotus 1-2-3 
 

Uses of Spreadsheets 
1. Accounting  
 Prepare budgets 
 Calculate profits 

 
2. Statistical analysis 
 Calculating statistical values e.g. mean, median etc. 

 
3. Data management  
 Organizes data in tabular manner 
 Operations include sorting, filtering etc. 

 
4. Tracking value of assets  
 Calculating appreciation and depreciation. 

 
5. Forecasting 
 Its automatic recalculation feature enables ‘what-if’ analysis 

 

Topic 2: Introduction to MS Excel 
 A product of Microsoft Corporation. 
 Versions: Excel 97, 2000, XP, 2003, 2007, 2010, 2013. 

Starting Excel 2007 
Step 1 Click the Start button on the taskbar  
Step 2 Point to All Programs or Programs 
Step 3 Point to Microsoft Office 
Step 4 Click Microsoft Office Excel 2007 
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Excel Terminology 
1. Cell – intersection of a row and a column. 
2. Cell Address - consists of column letter and row number. 
3. Range – a group of cells 
4. Active cell – highlighted by thick borders. 

 Location for typing into a worksheet. 
5.  Worksheet- MS Excel working area. 
 Consists of rows and columns 
 Contains 1,048,576 horizontal rows (numbered 1 through 1048576) and 16,384 vertical columns from column A 

to column XFD. 
6. Workbook – refers to an MS Excel spreadsheet file.  
 By default, consists of 3 worksheets. 

The Excel Cell Referencing System 
 Each cell has a unique address. 
 An address consists of column letter and row number. 
 There are two cell referencing styles, the:  

(i) A1 style - An address consists of column letter and row number e.g. B3, D2 etc. 
(ii) R1C1 style – both the row and the column are numbered e.g. R2C4 etc. 

 

The Excel window 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Excel Window Elements 
1. Microsoft Office Button – contains a pull down menu with most frequently used commands e.g commands used 

to create, open and save workbooks, and print worksheets 
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2. Quick Access Toolbar – a customizable toolbar 

 
 
 
 
 The Quick Access Toolbar (QAT) - provides a faster access to commands.  
 By default, the Quick Access Toolbar contains the Save, Undo, and Redo command buttons in addition to the 

Customize Quick Access Toolbar button. 
 You can add or remove command buttons on the Quick Access Toolbar to help you quickly perform common 

tasks. 
 
3. Title bar – contains the name of the workbook and  the name of the software 
4. Microsoft Office Excel Help button – used to access Excel Help. 
5. Minimize Window button – minimizes the current workbook to a title bar icon inside the Excel window. 
6. Restore Window button – restores the active workbook to a smaller window inside the Excel window. 
7. Close Window button – closes the active workbook. 
4. Scroll bars – vertical and horizontal scroll bars used to change the vertical or horizontal view of worksheet areas 
5. Status bar – a customizable bar below the worksheet area that is used to display various messages, the View 

Toolbar, the Zoom button and the Zoom Slider. 
6. View Shortcuts – contains view command buttons used to change the view of the active worksheet 
7. Zoom button – a command button used to change the magnification or “zoom” of the worksheet view 
8. Zoom Slider – a slide control used to change the magnification of “zoom” of the worksheet view 
9. The ribbon  
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 The Ribbon contains a series of grouped command buttons organized around specific tasks.  
 There are 3 parts to the ribbon – tabs, groups and commands. 

(i) Tab – designed to be task oriented. 
(ii) Tab group – divides a task into subtasks 
(iii) Command – carries out a command operation or displays a command menu. 

 
10. The Name Box- shows the cell reference of the active cell in the worksheet. 
11. The Formula Bar- shows the contents of the active cell.  
12. Column Headers - are the letters only at the top of the worksheet. 
13. Row Headers - are the numbers on the left side of each row of the worksheet. 
14. Active Cell - is the currently selected cell, displayed with a thick black border around the cell. 
15. Status bar-provides a message area, for example the Caps Lock or Num Lock “on” warning message, in addition 

to displaying the View Shortcuts, the Zoom command button, and the Zoom Slider. 
16. Sheet Tabs – 
 Identify the current worksheet. 
 Used to navigate from one worksheet to another. 

 
Navigating in a Worksheet 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The home cell – cell A1. 
 You can use the mouse pointer to navigate from one cell to another, thereby making the destination cell the 

active cell.  
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Keyboard shortcuts for navigating in a worksheet 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

Excel Data Types 
1. Labels 

 Any text and alphanumeric data 

 Used to make worksheet data more readable. 
2. Text  

 Any text and alphanumeric data 

 Cannot be manipulated mathematically 
3. Numbers 

 Numerical values that can be manipulated mathematically 
4. Date 

 Calendar values 
5. Time 

 Time values 
6. Formula 

 User defined mathematical expression 
7. Function  

 Excel inbuilt mathematical/text operations 
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Entering Text and Numbers 
 Make the appropriate cell the active cell and type in data e.g. B2 below and type the word Region 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 By default, text is aligned to the left while numbers to the right. 

 

Saving a Workbook 
 

 
 
 

Steps  
1. From the Office Button, select Save As. 
2. Select the file type. (Excel Workbook) 
3. Select the location/folder where you would like to save the workbook. e.g. C :> SCS114 > Exceldemo >Sales 
4. Name the file. e.g. Use your last name as the file name. 
5. Click Save. 
 

1

2
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Lab 1: Entering Text and Numbers 
1. Start a new MS Excel session 
2. Create the worksheet below  

 
 
 
 
 
 
 
 
 
 
 
 
 

3. Save it as SALES in a folder in drive D:. (Create a folder by your own name now if it does not exist) 

Entering numbers with fractions 
 To enter a fractional value into a cell, leave a space between the whole number and the fraction.  

 For example, to enter 67⁄8: enter 6, press spacebar then 7/8 and then press Enter.  

 If you have a fraction only e.g. 1⁄8: you must enter a zero first, like this: 0   1/8  

 Otherwise, Excel will likely assume that you’re entering a date. 

 N/B: Excel automatically simplifies fractions e.g 4/8 = 1/2 
 

Lab 2: Entering numbers with fractions 
1. Start a new workbook 
2. Create the worksheet below 
3. Save it as Fractions in your folder 
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Entering Numbers as Text 
 Precede the number with an apostrophe (‘) e.g ‘001, ‘002 
 
Lab3  
1. Start a new workbook session 
2. Create the worksheet below 
3. Save it as text  in your folder 
 
 
 

 
 

Entering Date/Time Data 
 Excel automatically recognizes valid date/time data type. 

 Examples of valid date formats:  11/6/05, 6-Nov-05, 6-Nov, Nov 05 

 Examples of valid time formats:  21:41, 21:41:35, 9:41 AM, 9:41:35 PM 

 There must be a space before AM/PM 

Lab 4: Entering date and time values  
1. Start a new workbook session  
2. Create the worksheet below 
3. Save it as date in your folder 
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Using AutoFill to enter a series of values 
 AutoFill- feature that inserts a series of values or text items in a range of cells. 
 
 
 
 
 
 
 
 
 
 
Procedure  
1. Enter the initial value e.g. 1 
2. Place the mouse pointer over the auto fill handle 

 It changes symbol from a white-plus-sign to a cross-hair 
3. Drag the AutoFill handle using the right mouse button. 
 Excel displays a shortcut menu with additional fill options. 
4.  Select Fill Series option from the shortcut menu 
 

Lab 6: Using Auto-Fill Feature  
1. Start a new workbook session  
2. Create the worksheet below by entering the initial value in each column and filling the rest of the values using 

auto-Fill Feature 
3. Save it as auto-fill in your folder 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Auto-Fill Handle 
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Lab 6: Applying all the Skills 
1. Start a new workbook session  
2. Create the worksheet below 
3. Save it as Fee in your folder 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Topic 3: Formatting Numbers 
• Values that you enter into cells normally are unformatted (General format). 
• You format the numbers so that they’re easier to read or are more consistent in terms of the number of decimal 

places shown. 
 

1. General 
• The General format is Excel's standard number format;. 
• Every cell starts out with the same number format: General.  
• This format comes with a couple of basic rules: 
1. If a number has any decimal places, Excel displays them, provided they fit in the column. If the number's got 

more decimal places than Excel can display, it leaves out the ones that don't fit. i.e.  It rounds up the last 
displayed digit, when appropriate. 

2. Excel removes leading and trailing zeros. Thus, 004.00 becomes 4.  
 
2. Number 

• The Number format is like the General format but with three refinements: 
1. First, it uses a fixed number of decimal places (which you set).  
2.  It also allows you to use commas as a separator between groups of three digits. 
3. Can display negative numbers displayed with the negative sign, in parentheses, or in red lettering. 

 
3. Currency 

• The Currency format displays the currency symbol before the number.  
• Always includes commas.  
• Also supports a fixed number of decimal places (chosen by you), and it allows you to customize how negative 

numbers are displayed. 
 

4. Accounting 
• The Accounting format is modeled on the Currency format.  
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• It also allows you to choose a currency symbol, uses commas, and has a fixed number of decimal places.  
• The currency symbol's always at the far left of the cell (away from the number), and there's always an extra 

space that pads the right side of the cell.  
• Also, the Accounting format always shows negative numbers in parentheses, which is an accounting 

standard.  
• The number 0 is never shown when using the Accounting format. Instead, a dash (-) is displayed in its place.  

 
5. Percentage 

• The Percentage format displays fractional numbers as percentages. For example, if you enter 0.5, that 
translates to 50%.  

• You can choose the number of decimal places to display. 
 

6. Fraction 
• The Fraction format displays your number as a fraction instead of a number with decimal places.  
• The Fraction format doesn't mean you have to enter the number as a fraction 

 
7. Scientific 

• Scientific notation displays the first non-zero digit of a number, followed by a fixed number of digits, and 
then indicates what power of 10 that number needs to be multiplied by to generate the original number. For 
example, 0.0003 becomes 3.00 x 10-4 (displayed in Excel as 3.00E-04).  

• The number 300, on the other hand, becomes 3.00 x 102 (displayed in Excel as 3.00E02).  
 

8. Text 
• The Text format simply displays a number as though it were text, although you can still perform calculations 

with it. 
•  Excel positions it against the left edge of the column.  

Steps for Formatting a Number 
1. Select the cell or range of cells 
2. Right-click the selection 
3. Choose Format Cells option from the context menu.  
4. Choose a category 
5. Choose a format similar to the one you desire 

 

Lab 3.1  
1. Start a new workbook 
2. Create the work sheet below 
 

 
 
 
3. Format it to appear as shown below 
4. Save it as Format. 
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• If a cell displays a series of hash marks (such as #########), it usually means that the column isn’t wide 

enough to display the value in the number format that you selected. 
•  Either make the column wider or change the number format. 

 
 

Topic 4: Creating Formula 
• A formula is a mathematical expression that returns a value 
• A formula is written using operators that combine different values, returning a single value that is then displayed 

in the cell. 
• The most commonly used operators are arithmetic operators. 

Excel Arithmetic Operators 
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Operator Precedence 
 

 
• Excel reads a formula containing these operators from left to right and performs the calculations following these 

strict rules of precedence: 
1. Parenthetical calculations first 
2. Division or multiplication next in the order in which the calculations appear from left to right 
3. Addition or subtraction next in the order in which the calculations appear from left to right 
 

 For example, consider the following formula: 
=5 + 2 * 2 ^ 3 - 1  
To arrive at the answer of 20, Excel first performs the exponentiation (2 to the power of 3): 
=5 + 2 * 8 - 1  
and then the multiplication: 
=5 + 16 - 1  
and then the addition and subtraction: 
=20 

• To control this order, you can add parentheses. 
• 5 + (2 * (2 ^ 3)) - 1 = 20 
• 5 + 2 * 2 ^ (3 - 1) = 13 
•  (5 + 2) * 2 ^ 3 - 1 = 55  
• (5 + 2) * 2 ^ (3 - 1) = 28 
 

Creating a Simple Formula 
• A formula is expressed by reference to cell addresses e.g. = A1+ A2 
• Must be preceded by an equal (=) sign. 
 
Copying a Formula 

 Drag the Autofill handle through the cells that the formula is to be copied. 

 Alternatively 
1. Right click on the cell that contains the formula 
2. Make cell where the formula is to be copied the active cell 
3. Right click on the active cell (cell where the formula is to be copied) 
4. Select Paste from the Shortcut Menu 
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Lab 3.1  
1. Start a new workbook 
2. Create the work sheet below 
3. Enter formula cell E3 as shown  
4. Press enter to view the answer  
5. Copy the formula to fill the Purchase Amount for the other items 
6. Save it as STOCK 
 

 
7. Set the Selling Price such that a profit of 25% is realized. (In Cell F3 enter the formula: =C3*1.25) 
8. Copy the formula to down to cell F6 
9. Find the Sell amount for each Item ( In Cell H3 enter the formula: =F3*G3) 
10. Copy the formula down to H6 
11. Find the Stock level for each Item (Qty Purchased – Qty Sold) 
12. Copy the formula down to H6 
13. Find the summation for all the values 
14. Find the average for all the values. Format the values appropriately e.g. quantity must be a whole number while 

monetary values should be to 2 decimal places. 
15. Resave the workbook. 

 Your worksheet should look like the one below. 
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Types of Cell References 
• There are three types of references: 
1. Relative: The row and column references can change when you copy the formula to another cell.  
• Is the default cell reference mode. 
• Example: A2 
2. Absolute: The row and column references do not change when you copy the formula. 

 Necessary when there is a constant in a formula. 

 Both the column letter and row number are preceded by the dollar ($) sign 

 Example: $A$2 
3. Mixed: Either the row or column reference is relative, and the other is absolute. 

 Example: A$2, $A2 

Lab 3.2 
1. Start a new workbook 
2. Create the work sheet below 
3. Enter formula cell b4 as shown  
4. Copy the formula downwards up to cell B9 
5. Save the workbook as Dollar. 
 

 
 

Common Formula Errors 
1. #VALUE! 

• You used the wrong type of data. E.g. you might have used a function or created a simple arithmetic formula 
with a cell that contains text instead of numbers. 

2. #NAME? 
• Excel can't find the name of the function you used.  
• This error code usually means you misspelled a function's name. 
3. NUM! 
• This error code appears when a calculation produces a number that's too large or too small for Excel to deal 

with. 
4. #DIV/0 

• You tried to divide by zero.  
• This error code also appears if you try to divide by a cell that's blank, because Excel treats a blank cell as 

though it contains the number 0 for the purpose of simple calculations with the arithmetic operators. 
5. #REF! 

• Your cell reference is invalid.  
• This error most often occurs if you delete or paste over the cells you were using. 
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6. #N/A 
• The value isn't available.  
• This error can occur if you try to perform certain types of lookup or statistical functions that work with cell 

ranges.  
7. #NULL! 

• You used the intersection operator incorrectly.  
• The intersection operator finds cells that two ranges share in common. This error results if there are no cells 

in common.  
8. ######## 
•  Excel has successfully calculated your formula. However, the formula can't be displayed in the cell using the 

current number format.  
• To solve this problem, you can widen the column, or possibly change the number format. 
 
 

Topic 5: Functions 
• Inbuilt MS Excel text or mathematical operation that returns a value given a range of values (arguments).  
• Identified by its name e.g. SUM (), PRODUCT (), etc. 

 

Function Categories 
• Functions are grouped into broad categories by some common features among them.  
1. Financial  
• Analyze investments including appreciation, depreciation, compound interest etc. 

 
2. Date & Time 
• Manipulates date and time values. 

 
3. Math & Trig 
• Includes general math and trigonometric functions. 

 
4. Statistical  
• Performs calculations on list of values. 

 
5. Lookup & reference 
• A lookup formula essentially returns a value from a table by looking up another related value. 

 
6. Database  
• Performs statistical calculations and queries on databases.  

 
7. Logical  
• Capable of making a decision based on the outcome of a Boolean expression. 

 
8. Information   
• Returns information about a cell e.g. the formatting features applied to the cell. 

 
9. Engineering 
• Includes common engineering calculations 

 
10. Text 
• Manipulates text data  
 

General Mathematical functions 
1. SUM()  
2. PRODUCT() 
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3. EXP() 
4. POWER() 
5. ROUND() 
6. SQRT() 

 
SUM ( ) 
• Adds up a group of cells. 
• Format: =SUM(range) 
• Range can be specified in 2 ways: 

(i) =SUM(A1,A2) -adds two cells. 
(ii) =SUM(A2:A12)- adds the range of 11 cells from A2 to A12. 

 
PRODUCT () 

 The PRODUCT( ) function takes a list of numbers, multiplies them together, and gives the result.  
(i) =PRODUCT(A1,A2,A3) 
(ii) =PRODUCT(A1:A10) 

 Takes a range of values as its argument 
 

Rounding Numbers 
1. ROUND( ) 
• Rounds a numeric value to a specified number of significant figures e.g. decimal places.  
• Format: ROUND(value,d.p.)    
• For example 
•  =ROUND(3.987, 2) The result is 3.99. 
• If you specify 0 for the number of d.p., then Excel rounds to the nearest whole number.  
 
2.  ROUNDDOWN( ) 
• Rounds numbers down, towards zero. 
• the result of ROUNDDOWN(1.9, 0) is 1,  
 
3.  ROUNDUP( ):  
• Rounds numbers up, away from zero. 
• the result of ROUNDUP(1.1, 0) is 2  
 
POWER() 
• POWER( ) works out exponents. 
•  =POWER(2,3) => 8 
• Takes two arguments, the base and the index.  
 
SQRT() 
• SQRT() finds the square root of a number. 
• =SQRT(9)=->3 
• Takes a single argument  

Statistical Functions 
1. COUNT() 
2. MAX() 
3. MIN() 
4. LARGE() 
5. SMALL() 
6. RANK() 
7. AVERAGE() 
8. MEDIAN() 
9. MODE() 
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Counting Values 
1. COUNT () 

 Returns the number of cells that contain a numeric value or date value. 

 Format: = COUNT(Range) 

 Example: =COUNT(A1:A10) 

 Function ignores blank cells and cells with text data. 
 
2. COUNTA () 
• Returns the number of cells with any data type. 
• Used to determine the number of nonblank cells. 

• Format: = COUNT(Range) 
• Example: =COUNTA(A1:A10) 

• Function ignores blank cells 
 
3. COUNTBLANK () 

 Returns the number of blank cells 

 Format: = COUNT(Range) 

 Example: =COUNTBLANK(A1:A10) 
 

Maximum and Minimum Values  
1. The MAX( )  
• Pick the largest value out of a series of cells. 
• Format: =Max(range) 
• Example: =Max(A1:A10) 

 
2. MIN( )  
• Returns smallest value out of a series of cells. 
• Format: =Min(range) 
• Example: =Min(A1:A10) 

 
Note: 

1. The MAX( ) and MIN( ) functions ignore any non-numeric content, which includes text, empty cells, and Boolean 
(true or false) values. 

2. Excel includes dates in MAX( ) and MIN( ) calculations because it stores them internally as the number of days 
that have passed since a particular date. 

Ranking Your Numbers 
1. LARGE( ) 
• Returns the k-th largest value in a list e.g. the 5th largest value in a list. 
• Example: =Large(A1:A10,5) 

 
2. SMALL() 
• Returns the k-th smallest value in a list e.g. the 5th smallest value in a list. 
• Example: =SMALL(A1:A10,5) 
• Takes two arguments: range and position in the list (range). 
 
3. RANK( )  
• Function finds where a specific value falls in the list. 
• Format : =RANK(number, range, [order_type]) 
• Example : 

=RANK(A1,A1:A10) – ascending order 
=RANK(A1,A1:A10,1) – descending order 

Measuring Central Tendency  
1. AVERAGE( ) 
• Finds the mean of a list of values 
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• Format: =AVERAGE(A1:A10) 
• Takes one argument: the range of values. 
• Function ignores all empty cells or text values. 
 
2. MEDIAN( ) 
• Finds the median of a list of values. 
• If the list is ordered in ascending order, the median is the value that lies in the middle position. 
• Format: =MEDIAN(A2:A12) 
 
3. MODE( ) 
• Returns the value that appears the highest number of times in a list (range) of values. 
• Format: =MODE(A1:A10) 
• Takes one argument: the range. 
• It ignores text values and empty cells  
 

Lab 5.1: Functions  
1. Create the workbook below  
2. Use functions to fill the gaps. 
3.  Save it as Exam. 
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Text Functions  
CONCATENATE( ) function  

 The CONCATENATE( ) function lets you join together text in exactly the same way the & operator does. 
LEN( ) Function 

 LEN( ) (short for LENgth) counts the number of characters in a string of text. For example, the result of 
the following formula is 5: 

 =LEN("Hello") 
Manipulating Text 
The concatenation operator (&) 

 Joins text together. 
 
 

DATE/TIME Functions 
1). TODAY() Function 

 The function displays the current date in a cell: 
=TODAY()  
 
2). DAY()Function 

 Function takes a date argument and returns a number representing the day (1 to 31). 
 
3). MONTH() 

 Function takes a date argument and returns a number representing the month (1 to 12). 
 
4). YEAR() 

 Function takes a date argument and returns a number representing the year (1900 to 9999).  

 Example, if you place the date 1/1/2007 in cell A1, the following formula displays a result of 2007: 
 =YEAR(A1) 
 
5). The NETWORKDAYS() Function 

 The NETWORKDAYS() function calculates the number of work days between two dates, excluding 
weekend days (Saturdays and Sundays).  

 As an option, you can specify a range of cells that contain the dates of holidays, which are also 
excluded.  

 Format: 
=NETWORKDAYS(StartDate,EndDate,[HolidayRange]) 

 Example: 
=NETWORKDAYS(A15,16,B2:B11) 
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6). WORKDAY() function 
• The WORKDAY() function gives an offset work day.  
• Example: function to determine the date that is ten working days from January 4, 2008: 

=WORKDAY(1/4/2008,10) 
 
7). The WEEKDAY() function  
• The WEEKDAY() function accepts a date argument and returns an integer between 1 and 7 that 

corresponds to the day of the week.  
• Sunday -1,Monday-2…………Saturday-7 
• =WEEKDAY(11/1/2011) 
 
Manipulating Dates and Times 

 Date and Time values can be involved in calculations like addition, subtraction, and so on. For example, 
consider this formula: 

 =A2-A1+1 

 If A2 contains the value 10/30/2007, and A1 contains the value 3/20/2007, the result is 224, which is 
the number of days between these two dates. 

 

Lookup Functions 
1. HLOOKUP()  
• is the horizontal lookup function.  
• HLOOKUP( ) works by scanning the values in a single row from left to right. Once it finds the entry 

you're looking for, it can then retrieve other information from the same column. 
• Format: 

=HLOOKUP(SearchValue, TableRange, rowNumber, [rangeLookup]) 

 Example: 
 

2. VLOOKUP()  
• Is the vertical lookup function. 
•  VLOOKUP( ) works by scanning the values in a single column from top to bottom.  
• Once it finds the entry you're looking for, it can then retrieve other information from the same row. 
• Format: 
• VLOOKUP(search_for  value, table_range, column_number)  
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Financial Functions 
Financial Concepts 
1. Present Value (PV). - The value of an investment or loan at the very beginning of its life. This number's 

also called the principal. 
2. Rate - The rate at which an investment or loan will increase or decrease.  
3. Future Value (FV) - The value of an investment or loan at some point in the future. 
4. Payment -An amount of money that's being contributed to an investment or loan. It's a regular 

contribution that's usually made at the same time the interest is calculated. 
5. Number of Payment Periods (NPER)-The total number of payment periods between the present value 

and the future value of an investment or loan.  
6. If you've got a three-year car loan (with payments due monthly), then the NPER equals 36. In other 

words, there are 12 payment periods each year, for three years. 
 

1). FV( ): Future Value Function 

 The FV( ) function lets you calculate the future value of an investment, assuming a fixed interest rate. 

  It lets you factor in regular payments, which makes it perfect for calculating how money's 
accumulating in a retirement or savings account. 

• Format:   
=FV(rate, nper, payment, [pv], [type])  

1. Rate -the interest rate your investment's earning. 
2. nper -the number of interest payments.  
• If your account receives interest once a year and you invest your money over a two-year period, then 

the nper will be 2.  
• If you're making regular contributions, this value also specifies the number of contributions you're 

making. FV( ) assumes that every contribution's made on the same day as the interest's generated. 
3. payment -the amount of the contribution you want to make regularly.  
• Set this to 0 if you don't want to add anything. 
4. pv -the present value, or the initial balance of your account.  
• If you omit this value, then Excel assumes you start with nothing. As a result, you'll need to include 

something other than 0 for the payment. 
5. type - indicates the timing of the payment. If you specify 0 (or omit this value), then the payment's made 
at the end of the period.  

• If you specify 1, then the payment's made at the beginning, giving your interest just a little bit more time to 
compound. 
• N/B:- make sure both the payment and the initial balance (pv) are negative numbers (or zero values).  

In Excel's thinking, the initial balance and the regular contributions are money you're handing over, so 
these numbers, consequently, need to be negative. The final value is positive because that's the total 
you're getting back. 
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• the formula that calculates the return on a $10,000 investment after one year earning 5 percent annual 
interest: 

• =FV(5%, 1, 0, -10000,0) 
• what happens if you switch to an account that pays monthly interest? 
•  You now have 12 interest payment periods per year, and each one pays a twelfth of the total 5 percent 

interest 
• =FV(5%/12, 12, 0, -10000)  

 The new total earned is a slightly improved $10,511.62. 
 

Loan Repayment 
• FV( ) works just as well on loan payments. 
• Example -you take out a $10,000 loan and decide to repay $200 monthly. Interest is set at 7 percent 

and calculated monthly.   
• FV() can tells you your outstanding balance that is, the amount that you still owe,  after three years as 

follows: 
• =FV(7%/12, 3*12, -200, 10000) 
 
2). PV( ): Present Value Function 
• The PV( ) function calculates the initial value of an investment or a loan (which is also called the present 

value).  
• Format: 
• =PV(rate, nper, payment, [fv], [type])  
• the real purpose of PV( ) is to answer hypothetical questions. 
• Consider this formula: 
• =PV(10%/12, 25*12, 0, 1000000)  

The question Excel answers here is: In order to end up with $1,000,000, how much money do I need to 
invest initially, assuming a 10 percent annual interest rate (compounded monthly) and a maturation 
period of 25 years? The PV( ) function returns a modest result of $82,939.75. 

• You can supplement your principal with a regular investment. The following formula assumes a 
monthly payment of $200, paid at the beginning of each month. Note that you should type in a 
negative number, because it's money you're giving up: 

• =PV(10%/12, 25*12, -200, 1000000)  
 
3). PMT( ) Function 
• The PMT( ) function calculates the amount of the regular payments you need to make, either to pay off 

a loan or to achieve a desired investment target.  
• You specify the present value and future value of the investment and the rate of interest over its 

lifetime, and the function returns the payment you'd need to make in each time period. Here's how the 
function breaks down: 

• Format: 
=PMT(rate, nper, pv, [fv], [type]) 

• If you don't specify a future value, then Excel assumes it's 0 (which is correct if you're performing the 
calculation to see how long it'll take to pay off a loan).  

• Once again, the type argument indicates whether you make payments at the beginning of the payment 
period (1) or at the end (0). 

• Example :- If you have a 7 percent interest rate (compounded monthly) and a starting balance of 
$10,000, how much do you need to pay monthly to top it up to $1,000,000 in 30 years? The PMT( ) 
function provides your answer: 

• =PMT(7%/12, 12*30, -10000, 1000000)  
The result$753.16is a negative number because this is money that you're giving up each month. 

• A loan calculation is just as easy, although, in this case, the present value becomes positive, since it 
represents money you received when you took out the loan. To determine the payments needed to 
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pay back a $10,000 loan (that comes with a 10 percent annual interest rate) over five years, you need 
this formula: 

• =PMT(10%/12, 12*5, 10000, 0)  
Assuming you make payments at the end of each month, the monthly payment is $212.47. If you add a 
type argument of 1 to pay at the beginning of the month, then this amount decreases to $210.71. 
 

4). NPER( ): Number of payment Periods Function  
• The NPER( ) function calculates the amount of time it will take you to pay off a loan or meet an 

investment target, provided you already know the initial balance, the interest rate, and the amount 
you're prepared to contribute for each payment.  

• Format :  
=NPER(rate, pmt, pv, [fv], [type]) 
• Example : If you're ready to contribute $150 a month into a savings account that pays 3.5 percent 

interest, you can use the following formula to determine how long it'll take to afford a new $4500 
plasma television, assuming you start off with an initial balance of $500: 

• =NPER(3.5%/12, -150, -500, 4500)  
The answer is 25.48 payment periods. Remember, a payment period in this example is one month, so 
you need to save for over two years. 

• A similar calculation can tell you how long it'll take to pay off a line of credit. Assuming the line of 
credit's $10,000 at 6 percent, and you pay $500 monthly, here's the formula you would use: 

• =NPER(6%/12, -500, 10000, 0)  
In this case, the news isn't so good: It'll take 21 months before you're rid of your debt. 

 

Charts  

Definition  
 A chart is a visual (graphical) representation of numeric values. 

 

Chart elements 
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Types of Charts 
 Chart Type Use 

1.  Column  Compares categories of data in vertical format. 

2.  Bar  Compares multiple values in horizontal format. 

3.  Line  Displays trends in data over time. 

4.  Pie  Compares data as part of a contribution to a whole. 

5.  Scatter  Plot Compares pairs of values in a dot format. 

6.  Area  Compares the trend of values over time or categories. 

7.  Doughnut  Compares multiple series of data in a percent format. 

8.  Radar  Displays changes in values relative to a center point. 

9.  Surface  Displays trends in values across two dimensions. 

10.  Bubble  Compares sets of three values. 

11.  Stock  Displays a chart to compare stock prices. 

12.  Cylinder  Same as a column or bar chart, but a cylinder is used instead. 

13.  Cone  Same as a column or bar chart, but a cone is used instead. 

14.  Pyramid  Same as a column or bar chart, but a pyramid is used instead. 

 

Choosing a chart Type 
Chart Type What It Does When to Use It 

Column  Depicts data as vertical bars; 
perhaps the most commonly used 
type 

When you need to present individual sets of 
data (e.g., sales totals by different 
departments) 

Line  Depicts data as a series of lines When you want to present data that varies 
over time (e.g., a student’s test scores) 

Pie  Characterizes only one data series 
as a series of slices, each 
contributing to a whole 

If, for example, you need to portray 
different departments’ percentages of an 
overall company budget 

Bar  Basically depicts a column chart 
whose data series are presented 
horizontally instead of vertically 

As per a column chart, but here the data 
bars extend sideways 

Area  Depicts a line chart whose data 
fills in the areas between the lines 
and the x-axis (take a look at the 
Area button) 

When you want to convey the relative depth 
of data (e.g., a test score of 90 will cover 
more area than a score of 75) 

Scatter  Portrays data along two value axes 
(that term will be defined shortly), 
thus treating data as paired 
values.,  

When you want to look at data organized by 
two quantitative variables at the same time, 
e.g., plotting marathon times by age of the 
runners. 

Other  Encompasses a collection of less 
commonly used charts. 

When you need a specialized chart, such as 
for a stock market comparison 

 

Inserting a chart  
1 Click a cell in the data list you want to summarize. 
2 Click the Insert tab. 
3 Click the type of chart you want to create. 
4 Click the chart subtype you want to use.  
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Adding chart elements 
Show or Hide a Chart Legend 
1 Click the chart you want to format. 
2 Click the Layout tab. 
3 Click Legend. 
4 Click a legend display option. 
 
Add Titles 
1 Click the chart you want to format. 
2 Click the Layout tab. 
3 Click Chart Title. 
4 Click the title display option you want. 
5 Click the title, and then type the new title for the chart.  
 
Add and Remove Data Labels 
1 Click the chart you want to format. 
2 Click the Layout tab. 
3 Click Data Labels. 
4 Click a data label option. 
 
Show or Hide Chart Gridlines 
1 Click the chart you want to format. 
2 Click the Layout tab. 
3 Click Gridlines. 
4 Click the set of gridlines you want to change. 
5 Click a gridline display option.  
 
Add a New Series 
1 Click the chart you want to change. 
2 Click the Design tab. 
3 Click Select Data. 
4 Click Add. 
5 Type the name you want to assign to the series. 
6 Click in the Series Values field. 
7 Select the cells you want to add. 
8 Click OK. 
9 Click OK. 
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What-If Analysis 
 One of the most appealing aspects of Excel is its ability to create dynamic models.  

 A dynamic model uses formulas that instantly recalculate when you change values in cells that are used 
by the formulas.  

 When you change values in cells in a systematic manner and observe the effects on specific formula 
cells, you’re performing a type of what-if analysis. 

 

Types of What-If Analyses 
1. Manual what-if analysis: Plug in new values and observe the effects on formula cells. 
2. Data tables: Create a special type of table that displays the results of selected formula cell as you 

systematically change one or two input cells. 
3. Scenario Manager: Create named scenarios and generate reports that use outlines or pivot tables. 
 

Manual what-if analysis 

 Manual what-if analysis is based on the idea that you have one or more input cells that affect one or 
more key formula cells. You change the value in the input cells and see what happens to the formula 
cells. 

Example: 

 
With this worksheet, you can easily answer the following what-if questions: 

i). What if I can negotiate a lower purchase price on the property? 
ii). What if the lender requires a 20-percent down payment? 
iii). What if I can get a 40-year mortgage? 
iv). What if the interest rate increases to 7.0 percent? 

 

 You can answer these questions by simply changing the values in the cells in range C4:C7 and observing 
the effects in the dependent cells (C10:C13).  

 

 

Data Tables 
 A data table is a dynamic range that summarizes formula cells for varying input cells.  

 You can create a data table fairly easily, but data tables have some limitations. In particular, a data 
table can deal with only one or two input cells at a time. 

FORMULA  
C10  =C4*(1-C5) 
C11 =PMT(C7/12,C6,-C4) 
C12 =C11*C6 
C13 =C12-C10 
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Creating a one-input data table 

 A one-input data table displays the results of one or more formulas for various values of a single input 
cell. 

 The Figure below shows the general layout for a one-input data table. 
 

 
 You can place the data table anywhere in a worksheet. The left column contains various values for the 

single input cell.  

 The top row contains references to formulas located elsewhere in the worksheet. You can use a single 
formula reference or any number of formula references. The upper-left cell of the table remains empty.  

 Excel calculates the values that result from each value of the input cell and places them under each 
formula reference. 

 

Example: 

 This example uses the mortgage loan worksheet from earlier in the chapter (see “A What-If Example”). 
The goal of this exercise is to create a data table that shows the values of the four formula cells (loan 
amount, monthly payment, total payments, and total interest) for various interest rates ranging from 6 
to 8 percent, in 0.25-percent increments. 

 

Solution 

 Figure 2 below shows the setup for the data table area.  

 Row 3 consists of references to the formulas in the worksheet. For example, cell F3 contains the 
formula =C10, and cell G3 contains the formula =C11. 

 Column E contains the values of the single input cell (interest rate) that Excel will use in the table. 
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 To create the table, select the data table range (in this case, E3:I12) and then choose : 

Data ➪ Data Tools ➪ What-If Analysis ➪ Data Table.  
Excel displays the Data Table dialog box, shown in Figure below. 

 You must specify the worksheet cell that contains the input value. Because variables for the input cell 
appear in the left column in the data table, you place this cell reference in the Column Input Cell field. 
Enter C7 or point to the cell in the worksheet. Leave the Row Input Cell field blank. Click OK, and Excel 
fills in the table with the calculated results . 

  

 
 

 Using this table, you can now see the calculated loan values for varying interest rates. If you examine 
the contents of the cells that Excel entered as a result of this command, you’ll see that the data is 
generated with a multicell array formula: {=TABLE(,C7)} 
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Using Scenario Manager 
 Data tables are useful, but they have a few limitations: 
i). You can vary only one or two input cells at a time. 
ii). Setting up a data table is not very intuitive. 
iii). A two-input table shows the results of only one formula cell although you can create additional tables 

for more formulas. 

 In many situations, you’re interested in a few select combinations, not an entire table that shows all 
possible combinations of two input cells. 

 The Scenario Manager feature makes automating your what-if models easy. You can store different 
sets of input values (called changing cells in the terminology of Scenario Manager) for any number of 
variables and give a name to each set.  

 You can then select a set of values by name, and Excel displays the worksheet by using those values.  

 You can also generate a summary report that shows the effect of various combinations of values on any 
number of result cells. These summary reports can be an outline or a pivot table. 

 For example, your annual sales forecast may depend upon several factors. Consequently, you can 
define three scenarios: best case, worst case, and most likely case. You then can switch to any of these 
scenarios by selecting the named scenario from a list. Excel substitutes the appropriate input values in 
your worksheet and recalculates the formulas. 
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Defining scenarios 

 The figure below is an example that uses a simplified production model. 
 

 
 
 

 This worksheet contains two input cells: the hourly labor cost (cell B2) and the unit cost for materials 
(cell B3).  

 The company produces three products, and each product requires a different number of hours and a 
different amount of materials to produce. 

 Formulas calculate the total profit per product (row 13) and the total combined profit (cell B15). 

 Management — trying to predict the total profit, but uncertain what the hourly labor cost and material 
costs will be — has identified three scenarios, listed in Table below 

 

 
 The Best Case scenario has the lowest hourly cost and lowest materials cost.  

 The Worst Case scenario has high values for both the hourly cost and the materials cost. 

 The third scenario, Most Likely Case, has intermediate values for both of these input cells.  

 The managers need to be prepared for the worst case, however, and they’re interested in what would 
happen under the Best Case scenario. 

 

Solution  

 Choose Data ➪ Data Tools ➪ What-If Analysis ➪ Scenario Manger to display the Scenario Manager 
dialog box.  

 When you first open this dialog box, it tells you that no scenarios are defined — which is not too 
surprising because you’re just starting.  

 As you add named scenarios, they appear in the Scenarios list in this dialog box. 
 

B9: 
=(Hourly_labor_cost*B7)+(Material_cost*
B8) 
 
B11:  
=B10-B9 
 
B13 
=B11*B12 
 
B15: 
=SUM(B13:D13) 
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To add a scenario, click the Add button in the Scenario Manager dialog box. Excel displays its Add  Scenario dialog box, 
shown in Figure below 

 
 

 This dialog box consists of four parts: 
1. Scenario Name: You can give the scenario any name that you like — preferably something meaningful. 
2. Changing Cells: The input cells for the scenario. You can enter the cell addresses directly or point to 

them. If you’ve created a name for the cells, type the name.  
o The number of changing cells for a scenario is limited to 32. 

3. Comment: By default, Excel displays the name of the person who created the scenario and the date 
when it was created. You can change this text, add new text to it, or delete it. 

4. Protection: The two Protection options (preventing changes and hiding a scenario) are in effect only 
when you protect the worksheet and choose the Scenario option in the Protect Sheet dialog box. 
Protecting a scenario prevents anyone from modifying it; a hidden scenario doesn’t appear in the 
Scenario Manager dialog box. 
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 In this example, define the three scenarios that are listed in Table above. The changing cells are 
Hourly_Cost (B2) and Materials_Cost (B3). 

 After you enter the information in the Add Scenario dialog box, click OK. Excel then displays the 
Scenario Values dialog box, shown in Figure 36.12. This dialog box displays one field for each changing 
cell that you specified in the previous dialog box. Enter the values for each cell in the scenario. 

 

 
 
 

 If you click OK, you return to the Scenario Manager dialog box, which then displays your named 
scenario in its list. If you have more scenarios to create, click the Add button to return to the Add 
Scenario dialog box. 

 
 

Displaying scenarios 

 After you define all the scenarios and return to the Scenario Manager dialog box, the dialog box 
displays the names of your defined scenarios.  

 Select one of the scenarios and then click the Show button. Excel inserts the corresponding values into 
the changing cells and calculates the worksheet to show the results for that scenario. Figure below  
shows an example of selecting worst case scenario. 
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Reverse What-If Analysis 
 If you know what a formula result should be, Excel can tell you the values that you need to enter in one 

or more input cells to produce that result. In other words, you can ask a question such as “How much 
do sales need to increase to produce a profit of $1.2 million?”. 

 Excel provides two tools that are relevant: 
1. Goal Seek: Determines the value that you need to enter in a single input cell to produce a result that 

you want in a dependent (formula) cell. 
2. Solver: Determines the values that you need to enter in multiple input cells to produce a result that 

you want. Moreover, because you can specify certain constraints to the problem, you gain significant 
problem-solving ability. 

 

Single-Cell Goal Seeking 
 In Single-cell goal seeking, Excel determines what value in an input cell produces a desired result in a 

formula cell.  
 

A goal-seeking example 

 Figure below shows the mortgage loan worksheet used in the preceding chapter. This worksheet has 
four input cells (C4:C7) and four formula cells (C10:C13).  

 This example demonstrates the opposite approach. Rather than supply different input cell values to 
look at the calculated formulas, this example lets Excel determine one of the input values that will 
produce the desired result. 

 Assume that you’re in the market for a new home and you know that you can afford an $1,800 monthly 
mortgage payment. You also know that a lender can issue a 30-year fixed-rate mortgage loan for 
6.50%, based on an 80% loan-to-value (that is, a 20% down payment). The question is “What is the 
maximum purchase price I can handle?” In other words, what value in cell C4 causes the formula in cell 
C11 to result in $1,800?  

 In this simple example, you could plug values into cell C4 until C11 displays $1,800. With more complex 
models, Excel can usually determine the answer much more efficiently. 

 To answer the question posed in the preceding paragraph, first set up the input cells to match what 
you already know. Specifically: 

i). Enter 20% in cell C5 (the down payment percent) 
ii). Enter 360 in cell C6 (the loan term, in months) 
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iii). Enter 6.5% in cell C7 (the annual interest rate) 

 Next, choose Data ➪ Data Tools ➪ What-If Analysis ➪ Goal Seek. Excel displays the Goal Seek dialog 
box, shown in Figure below.  

 

 
 

 Completing this dialog box is similar to forming a sentence. You want to set cell C11 to 1800 by 
changing cell C4. Enter this information in the dialog box either by typing the cell references or by 
pointing with the mouse. Click OK to begin the goal-seeking process. 

 In less than a second, Excel displays the Goal Seek Status box, which shows the target value and the 
value that Excel calculated. In this case, Excel found an exact value. The worksheet now displays the 
found value in cell C4 ($355,974). As a result of this value, the monthly payment amount is $1,800. At 
this point, you have two options: 
i). Click OK to replace the original value with the found value. 
ii). Click Cancel to restore your worksheet to the form that it had before you chose Goal Seek. 
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More about goal seeking 
 Excel can’t always find a value that produces the result that you’re seeking. Sometimes, a solution 

simply doesn’t exist. In such a case, the Goal Seek Status box informs you of that fact. 

 Other times, however, Excel may report that it can’t find a solution, but you’re pretty sure that one 
exists. If that’s the case, you can try the following options: 

i). Change the current value of the By Changing Cell field in the Goal Seek dialog to a value that is closer to 
the solution and then reissue the command. 

ii). Adjust the Maximum iterations setting on the Formulas tab of the Excel Options dialog box (choose File 

➪ Excel Options). Increasing the number of iterations (or calculations) makes Excel try more possible 
solutions. 

iii). Double-check your logic and make sure that the formula cell does, indeed, depend upon the specified 
changing cell. 

 
 

Introducing Solver 
 The Excel Goal Seek feature is a useful tool, but it clearly has limitations. It can solve for only one 

adjustable cell, and it returns only a single solution.  

 Excel’s powerful Solver tool extends this concept by enabling you to do the following: 
i). Specify multiple adjustable cells. 
ii). Specify constraints on the values that the adjustable cells can have. 
iii). Generate a solution that maximizes or minimizes a particular worksheet cell. 
iv). Generate multiple solutions to a problem. 

 Although goal seeking is a relatively simple operation, using Solver can be much more complicated. 
 
 

 
 

Appropriate problems for Solver 
 Problems that are appropriate for Solver fall into a relatively narrow range. They typically involve 

situations that meet the following criteria: 
i). A target cell depends upon other cells and formulas. Typically, you want to maximize or minimize 

this target cell or set it equal to some value. 
ii). The target cell depends on a group of cells (called changing cells) that Solver can adjust to affect the 

target cell. 
iii). The solution must adhere to certain limitations, or constraints. 

 After you set up your worksheet appropriately, you can use Solver to adjust the changing cells and 
produce the result that you want in your target cell — and simultaneously meet all the constraints that 
you defined. 
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A simple Solver example 

 Figure below shows a worksheet that is set up to calculate the profit for three products. 

 Column B shows the number of units of each product, Column C shows the profit per unit for each 
product, and Column D contains formulas that calculate the total profit for each product by multiplying 
the units by the profit per unit. 
 
 

 
 

 You don’t need an MBA degree to realize that the greatest profit comes from Product C. Therefore, to 
maximize total profit, the logical solution is to produce only Product C.  If things were really this simple, 
you wouldn’t need tools such as Solver.  

 As in most situations, this company has some constraints that must be met: 
i). The combined production capacity is 300 total units per day. 
ii). The company needs 50 units of Product A to fill an existing order. 
iii). The company needs 40 units of Product B to fill an anticipated order. 
iv). Because the market for Product C is relatively limited, the company doesn’t want to produce more than 

40 units of this product. 

 These four constraints make the problem more realistic and a bit more challenging. In fact, it’s a 
perfect problem for Solver. 
 

Steps  

1. Set up the worksheet with values and formulas. Make sure that you format cells logically; for example, 
if you can’t produce partial units of your products, format those cells to contain numbers with no 
decimal values. 

2. Choose Data ➪ Analysis ➪ Solver to bring up the Solver Parameters dialog box. 
3. Specify the target cell. 
4. Specify the range that contains the changing cells. 
5. Specify the constraints. 
6. Change the Solver options, if necessary. 
7. Let Solver solve the problem. 
 

Solution  

 To start Solver to tackle this example, choose Data ➪ Analysis ➪ Solver. Excel displays its Solver 
Parameters dialog box, shown in Figure below. 
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 In this example, the target cell is D6 — the cell that calculates the total profit for three products. 
1. Enter D6 in the Set Objective field of the Solver Parameters dialog box. 
2. Because the objective is to maximize this cell, select the Max option button. 
3. Specify the changing cells (which are in the range B3:B5) in the By Changing Variable Cells field.  

 The next step is to specify the constraints on the problem. The constraints are added one at a time and 
appear in the Subject to the Constraints list. 

4. To add a constraint, click the Add button. Excel displays the Add Constraint dialog box, shown in below. 
This dialog box has three parts: a Cell Reference, an operator, and a Constraint value. 
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5. To set the first constraint (that the total production capacity is 300 units), enter B6 as the Cell 
Reference, choose equal (=) from the drop-down list of operators, and enter 300 as the Constraint value. 
6. Click Add, and enter the remaining constraints. Table below summarizes the constraints for this 
problem. 
 

 
 
7. After you enter the last constraint, click OK to return to the Solver Parameters dialog box, which now 
lists the four constraints. 
8. For the Solving Method, use the default, GRG Nonlinear. 
9. Click the Solve button to start the solution process. You can watch the progress onscreen, and Excel 
soon announces that it has found a solution. The Solver Results dialog box is shown in Figure below. 

 
 
 

 

 At this point, you have the following options: 
i). Keep the solution that Solver found. 
ii). Restore the original changing cell values. 
iii). Create any or all three reports that describe what Solver did. 
iv). Click the Save Scenario button to save the solution as a scenario so that Scenario Manager can use. 

 The Reports section of the Solver Results dialog box lets you select any or all of three optional reports.  

 If you specify any report options, Excel creates each report on a new worksheet, with an appropriate 
name.  

 Figure below shows an Answer Report, in the form of a collapsible outline (I chose the Outline Reports 
check box in the Solver Results dialog box). In the Constraints section of the report, three of the four 
constraints are binding, which means that these constraints were satisfied at their limit with no more 
room to change. 
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 This simple example illustrates how Solver works. The fact is, you could probably solve this particular 
problem manually just as quickly. That, of course, isn’t always the case. 

 At this point, you have the following options: 
i). Keep the solution that Solver found. 
ii). Restore the original changing cell values. 
iii). Create any or all three reports that describe what Solver did. 
iv). Click the Save Scenario button to save the solution as a scenario so that Scenario Manager can use 

it. 
 

More about Solver 

 It’s not unusual for Solver to report that it can’t find a solution, even when you know that one should 
exist. Often, you can change one or more of the Solver options and try again. 

  When you click the Options button in the Solver Parameters dialog box, Excel displays the Solver 
Options dialog box, shown in Figure below 
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This list describes Solver’s options: 

1. Constraint Precision: Specify how close the Cell Reference and Constraint formulas must be to 
satisfy a constraint. Excel may solve the problem more quickly if you specify less precision. 

2. Use Automatic Scaling: Use when the problem involves large differences in magnitude — when you 
attempt to maximize a percentage, for example, by varying cells that are very large. 

3. Show Iteration Results: Instruct Solver to pause and display the results after each iteration by 
selecting this check box. 

4. Ignore Integer Constraints: When this check box is selected, Solver ignores constraints that specify 
that a particular cell must be an integer. Using this option may allow Solver to find a solution that 
cannot be found otherwise. 

5. Max Time: Specify the maximum amount of time (in seconds) that you want Solver to spend on a 
problem. If Solver reports that it exceeded the time limit, you can increase the amount of time that 
it spends searching for a solution. 

6. Iterations: Enter the maximum number of trial solutions that you want Solver to perform. 
7. Max Subproblems: For complex problems. Specify the maximum number of subproblems that may 

be explored by the Evolutionary algorithm. 
8. Max Feasible Solutions: For complex problems. Specify the maximum number of feasible solutions 

that may be explored by the Evolutionary algorithm. 
 
 
 
 


